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1 Introduction
1.1 Features
GraphicConverter can translate either way between Macintosh image files and most of
the common ATARI, Amiga and IBM formats.
Pictures can be edited, compiled into a storyboard (including picture information) for
building animation lists or displayed as slide shows.
It has a Browser to help arrange folders of picture files, an editable layout for printing
pages of images and numerous tools for inspecting  and modifying picture information.
1.2 Requirements
GraphicConverter needs a PowerPC Mac or later or compatible; System 7.5.3 or later,
and 8 MB.
1.3 Registration
GraphicConverter is Shareware. You can test the program. If you like it, you should
register.
Registration costs:

Europe $30
Rest of the world $35

1.4 Payment
You can pay either by check or credit card. Send Eurocheque or cashiers check to the
following address:

Lemke Software
Erich-Heckel-Ring 8a
31228 Peine
Germany

Fax: +49-5171-72201

I can accept EUROCARD/MasterCard, VISA, Diners Club International or AMERICAN
EXPRESS. Please mail me your card number and expiration date. Please use the form
that GraphicConverter provides from the registration dialog.

E-Mail: support@graphicconverter.net
lemkesoft@aol.com

mailto:support@graphicconverter.net
mailto:lemkesoft@aol.com
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Updates are available from:

http://www.lemkesoft.de
http://www.lemkesoft.com
http://www.graphicconverter.net

This site has links to mirror sites on the download page. Please try to download from a
mirror whenever my server is busy.
Registered users can order the product with or without a CD ROM. Patches are
available from the above Internet address.
German, French, Swedish, Spanish, Danish and Italian versions are also available.
1.5 Restrictions
Keep all the GraphicConverter related files together including the program, ‘read me’,
documentation and history if you copy it for someone else.
1.6 Errors
If you find any bugs or errors in the program, please send me a list and/or the file that
produces the error.
1.7 For me
If you have information about other graphic formats, please send me a copy and a disk
with some files in that format.
1.8 Thanks
Thanks to those who have helped me improve this product with suggestions,
information or bug reports.
1.9 Legal Statements
The software and accompanying instructions are provided ‘as is’ without warranty of
any kind. The author Thorsten Lemke and Lemke Software do not warrant, guarantee,
or make any representations regarding the use or, or the results of the use of the
software or accompanying instructions in terms of correctness, accuracy, reliability,
currentness, or otherwise. The entire risk as to the results and performance of the
software is assumed by you. If the software or instructions are defective, you, and not
Thorsten Lemke or Lemke Software, assume the entire cost of all necessary servicing,
repair or correction.
1.10 About this Documentation
I wrote this documentation with Word 98. I used Snapz Pro and GraphicConverter for
the pictures. I produced the documentation application with eDoc. The name of the
rabbit in some of the pictures is Hoppel who belongs to my sister and her husband.
1.11 Copyright Notice
Apple, the Apple logo, and Macintosh are trademarks of Apple Computer, Inc.,
registered in the United States and other countries. Mac and the Mac OS logo are
trademarks of Apple Computer, Inc.
GIF- and TIFF-LZW Compression/Decompression are licensed under U.S. Patent No.
4.558.302 and foreign counterparts.
Photo CD mark licensed from Kodak.
Mercutio MDEF copyright Ramon M. Felciano 1992-1998

http://www.lemkesoft.de
http://www.lemkesoft.com
http://www.graphicconverter.net
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2 Preface
2.1 Words and Terms
This manual assumes that you are familiar with basic use of your Macintosh. I use these
standard terms in the following documentation.
2.2 Installation
The installation is very simple.
Mount the Disk Image with a double click on the DiskImage Symbol.

Open the mounted disk image with a double click on the symbol. Copy the
GraphicConverter folder onto your hard disk. No other files are required.
(GraphicConverter automatically generates a ‘Preferences file’ in the preferences folder
of the System Folder.)
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3 Menus
3.1 Apple Menu (Classic MacOS)
The Apple Menu contains information about GraphicConverter. It also contains the
desk accessories and the files in the Apple Menu Items folder.

3.1.1 About GraphicConverter…
This menu item displays you information about the version number and the shareware
agreement. In addition, you can fill out and print the order form or you can unregister a
registered version of GraphicConverter.
3.1.2 About Plug-ins/Add-ons
This menu item contains a submenu, which will show a list of all installed plug-ins. Plug-
in’s can be selected to display their individual “About” screens.

3.2 GraphicConverter Menu (MacOS X)
The GraphicConverter Menu contains information about GraphicConverter. It also
contains the menu item to quit the application.

3.2.1 About GraphicConverter…
This menu item displays you information about the version number and the shareware
agreement. In addition, you can fill out and print the order form or you can unregister a
registered version of GraphicConverter.
3.2.2 About Plug-ins/Add-ons
This menu item contains a submenu, which will show a list of all installed plug-ins. Plug-
in’s can be selected to display their individual “About” screens.
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3.3 File Menu
The File Menu contains all functions for the input and output of pictures.

3.3.1 New
The New menu item contains a submenu for creating new elements.



12

3.3.1.1 Image
This dialog sets the options for new pictures.

Available options are:
• Width
• Height
• Resolution
• Depth
• Color Table (for images up to 8 bits per pixel)

GraphicConverter opens a new blank picture with the selected characteristics.
3.3.1.2 Image with Clipboard
This creates a new picture (as opposed to pasting), using the contents of the clipboard.
3.3.1.3 Image with Clipboard...
This creates a new picture (as opposed to pasting), using the contents of the clipboard.
You can specify the size and color depth of the image before creating.



13

3.3.1.4 Layout
Opens a new layout page. You can place your currently open pictures using the
contextual menu (Control-click) directly into the layout window.
3.3.1.5 Storyboard
Display this menu item by holding the option key when opening the “File” menu. The
storyboard is designed to hold lists of file names (useful for arranging images for an
animation or slide show). Also, it can be used to sort images and change their names.
Storyboards can be saved, opened, and edited as separate documents.

• Add & Move files
Add or move files with a simple „drag-and-drop“ from the Finder.

• Selecting
Select a file with a mouse click. Multiple selections can be made with a shift-click and
range selections with a command-click.

• Duplication with the mouse
Click in the right bottom corner of a cell and move the mouse down or up. The
content of the cell will replace the content of the other cells.

• Replicating with a key
Select one or more files with the mouse. Press command F2 ... F10. The selected items
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will be replicated by the value of the number on the function key (e.g. F3 creates 3
replicas). The additional cells will move the other cells down.

Additional options are available from the contextual menu (Control-click inside the
storyboard window).

• Show all items in Slideshow
All files in the first column will be displayed in the slideshow.

• Save all Items as
Displays a dialog for saving files. All items in the first column will be saved in the
selected format according to the index options.

• Save all Items in Source Format as
Displays a dialog for saving files. All items in the first column will be copied to the
selected location, using the naming conventions chosen in index options.

• Invert or Reverse Order
Reverses the order of the selected items.

• Insert Row
Inserts a row at the cursor position.

• Delete Row
Deletes a row at the cursor position.

• Index Options
Displays the index options preferences. The storyboard uses the same settings as
“Convert More”.

3.3.1.6 List from Files
Select a folder in Get Folder dialog. GraphicConverter then opens all files in the folder
and looks at them, displaying the results in a window. If a list-window is already open, it
is closed automatically.
3.3.1.7 List from STR# Resources
Generates a list with the contents of one STR# resource.
Note: I added this function because in ResEdit it is not possible to print a complete STR#
resource.
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3.3.2 Open
Use this function to open a picture or a layout.
This displays the standard Open File dialog with some additional elements (the
appearance of the dialog depends on your system software):

• Filter
Use this to see only the file types in which you’re interested. Select the filter for
files you want to see.

• Create Preview
Creates a preview for the selected document(s).

• Show invisible files
Displays files that are invisible in the finder.

• Enlarge Preview
Enlarges small previews to fill the preview area/region/pane.
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3.3.3 Browse Folder
The Browser is a unique feature of GraphicConverter. First, select a folder containing
images. GraphicConverter then opens a window with the following elements:
• Folder list at the left

You can select a different folder here, or browse folder-by-folder.
• Folder content in the middle

Every file will be displayed with its preview (if available).
• Preview at the right

Displays a preview of the file you selected in the middle.

There are many different options:
• Select additional files with a shift-click.
• Move or copy (with option key) a selection from one browser window to another.

Especially useful for sorting of pictures.
• Move or copy (with option key) a selection from the content list to a folder in the

folder list. Helpful for sorting pictures.
• Open a file or folder with a double-click.
• Additional options are available from the contextual menu (Control-click inside the

Browser window).
Content of the context menu:
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• Refresh
Refreshes the display of the currently previewed folder by scanning the folder again.
You can use the F5 key as an alternative.

• Select All
Selects all files in the folder.

• Create Preview
Creates a preview for all selected files.

• Label
Changes the label of the selected items.

• Rename
You can rename the image in the list.
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• Delete selected File(s)
Deletes all selected files. Warning! Undo is NOT available!

• Move selected File(s) into Trash
Moves the selected files into the trash.

• New Folder
Creates a new folder.

• Set Date from File Content
This function sets the file date from the date field of the internal JPEG structure. This
is very useful for digital images from cameras (because a digital camera sets the
correct date in the JPEG; but the file date is normally wrong).

• View File(s) in Slideshow
Displays all selected files as a slideshow, using the default settings.

• Open with..
The submenu contains all open applications. You can select any one of them.
GraphicConverter tells the application to open the selected files. This may not work
if the application you select is unable to handle this file type.

• Rotate
Rotates the selected images. JPEGs will be rotated lossless if possible. You will get a
warning if this is not possible.

• Mirror
Mirrors the selected images. JPEGs will be mirrored lossless if possible. You will get a
warning if this is not possible.

• Hide/Show Footer
Hides or shows the footer.

• Preferences
Displays the Preferences dialog for the browser.

There are some options at the bottom of the window:
• Change the size of the previews.
• Sort

By Name, Size, Date
Up or down
Folder separate or alone

• Show/hide the folder list 

• Show/hide the preview 
• Drag the scrollbars left or right to vary the width of each list.
3.3.4 Close
Close the active window.
3.3.5 Close All
Closes all open windows.
3.3.6 Save
This allows saving the contents of the active window with the existing name. If no name
is defined, the ‘Save as’ dialog box will open instead.
3.3.7 Save All
Saves all open windows. If no name is defined, the ‘Save as’ dialog box will appear for
each window.
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3.3.8 Save as
Save the contents of the active window with a new name and format.
This is the standard file dialog with some additional elements (the appearance of the
dialog depends on your system software):

• Format
Allows selection of the picture format with the popup menu. Additional options for
some formats are also available (see later description).

• Options
Displays a dialog window to specify additional settings for the selected file format.

• Split
Displays a dialog window to specify the splitting settings. Use this function to save
one picture as two (or more) segemented pictures.

• Save only selection
Check this to save only the image area which is selected.
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• Create LOWSRC GIF file
Check this to get a GIF file with 16 greys, in addition to the present file. This is useful
for WEB graphics. Netscape and Internet Explorer both supports the LOWSRC tag.

• Set Format from Extension
Check this box if GraphicConverter should set the file format based on the file
extension

• Save web ready
Check this box if you want to upload or e-mail the image.

• Compress with StuffIt
Check this to compress the files after saving with the StuffIt Engine (if available).

3.3.8.1 ASCII Options
Options:

• Header
Defines the saved fields.

• Files
Defines the extensions of the files.

3.3.8.2 BMP Options
Options:
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• Format
Switch between Windows and OS/2 format.

• Compression
Choose between none and RLE compression. Note: RLE compression is not
supported in all Windows applications.

3.3.8.3 EPSF Options
Options:

• No Compression
The picture will be saved uncompressed.
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• RLE
The picture will be saved with RLE compression. This may create smaller EPSF files if
the image contains large areas with the same color.

• JPEG
The picture will be saved JPEG compressed (color).

• Preview
Adds a PICT preview in the resource fork of the file. Text processor applications use
this for a preview on the screen.

• Quality
Use to set the quality of JPEG compression.

3.3.8.4 Finder Picture Options
Finder pictures divides an image into icons which are displayed in a folder in icon view.
This format is mainly used for CD creation. The Lemke Software CD uses the same
technology. Don’t use this function to put an image on your desktop!

Options:
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• Create 4 Bit Icons
Check this option to have icons for old systems with less than 256 colors.

• Create White Icons
Check this option to save completely white icons.

• Create 32 Bit Icons
Check this option to create the new 32 bit icons. So, your image will be displayed in
true color under MacOS 8.5 or later. This option take a lot of disk space. But this
doesn’t matter normally on cds.

• Offset
Enter the offset of the finder picture in the folder from the top left. The minimum
offset should be 10. A smaller offset may cause display problems in the finder.

3.3.8.5 FireViewer PDB Options
Options:

• Colors
Select the number of used colors/grays depending on your PalmOS device.
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• Compression
RLE compression results normally in smaller file sizes. This is very useful for the
small memory in PalmOS devices.

3.3.8.6 GIF Options
Options:

• Version 87a
This is the original GIF format. It doesn’t support comments or transparent mode.
This version is supported by every GIF reader.

• Version 89a
This is the latest GIF format.

• Row Order
Select if the rows should be saved in normal or interlaced format. Interlacing is useful
for online services like CIS. This allows MACCIM to create a preview while
downloading.

• Depth Optimization
Check this to save GIFs with the optimal color depth. GraphicConverter will save a
picture that uses 28 colors automatically with only 5 bit (max. 32 colors) depth. This
will result in smaller files for WWW and other usage.

3.3.8.7 IFF Options
Options:
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• No Compression
The picture will be saved uncompressed. This is not supported by many applications.

• RLE
The picture will be saved using RLE compression. This is the standard setting.

3.3.8.8 IMG Options
Options:

• 24 Bit IMG
There is no standard for 24 bit img files. Choose the save method.

3.3.8.9 JPEG/JFIF Options
Options:
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• Quality
Adjust the picture quality. Lower quality produces smaller files. You can set the
quality with the slider or by entering the value in the edit field.

• Show Preview
Displays a preview for the selected quality setting. Please uncheck this option on slow
machines.

• Calculate File Size
Displays the file size with the selected quality. Please uncheck this option on slow
machines.

• Library
Allows selection of the compression library.

3.3.8.10 LuraWave
GraphicConverter supports, starting with version 3.9, the great LuraWave wavelet
compression technology. You can open every lwf image and save images up to 800x600
pixel. You can buy a license for the compression of larger images. The license fee is $12.
Simply select Apple Menu>About Plugins/Addons>LuraWave. The dialog will forward
you to the order url on the internet.

Options:
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• Mode
You select the compression mode.

• Password
You can define a password for the image. Also, you can set the display quality
without entering a password.

3.3.8.11 Moov QuickTime Options
This is the standard Mac dialog for QuickTime movie compression.
3.3.8.12 Photoshop Options
Options:

• No Compression
The picture will be saved uncompressed.

• RLE
The picture will be saved using RLE compression.

3.3.8.13 PICT Options
You have the following options:
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• Standard (RLE)
This PICT format can be opened on any Macintosh.

• QuickTime
This type of PICT can be opened only if QuickTime is installed. Click on options to
change the compression settings.

• Dither
Pictures will be automatically dithered after opening. This slows down the opening
process.

• Spool
This function is useful for opening large pictures if you do not have enough memory.

3.3.8.14 Resource Options
Use this to save a PICT in a resource file format.
Options:
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• Standard (RLE)
Every Macintosh can decompress and display this format.

• QuickTime
The picture will be compressed with QuickTime. Requires that the QuickTime
extension be in your system folder to use this compression/decompression method.
Click on Options… for additional settings.

• File Creator
Type the creator of the file. Use this to generate a file which can be opened with a
double-click for appropriate application programs, such as ResEdit.

• Resource
Save the pict to an existing resource file with this option.

• Dither
Pictures will be automatically dithered after opening. This slows down the opening
process.

• Spool
This function is useful for large pictures if you do not have enough memory.
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3.3.8.15 PNG Options
Options:

• Interlaced
Allows you to enable or disable the interlaced mode. Interlaced images will give a
fast preview in online systems. However, the compressed file will be a bit larger than
the non-interlaced version.

• Filter
PNG uses lossless filters to achieve a better compression ratio (smaller files). The
default settings will normally create the smallest files.

Note:
The “Automatically” option creates very small files. But it takes very long to calculate
the best compression.

3.3.8.16 PSION Options
Options:

• Compression
Allows you to enable or disable the compression. Depending on the content of the
picture, RLE compression may create smaller files.
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• 
3.3.8.17 RAW Options
Options:

• Header
Set the headers for the picture to be exported.

3.3.8.18 SGI Options
Options:

• B/W Verbatim
The picture will be saved uncompressed as 8 bit grayscale.

• B/W RLE
The picture will be saved using RLE compression as 8 bit grayscale.

• RGB Verbatim
The picture will be saved uncompressed as 24 bit RGB color.

• RGB RLE
The picture will be saved using RLE compression as 24 bit RGB color.
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3.3.8.19 StartupScreen (Classic MacOS) Options
Every Macintosh can display a startup picture (instead of the “Welcome to Macintosh”
screen). This requires a PICT format file, named „StartupScreen“ which is placed in the
System Folder. The PICT is inside the resource fork.
Options:

• Add Border
Adds a black border to the picture if it is smaller than  the width or height of your
screen.

3.3.8.20 TIFF Options
Options:

• No Compression
Saves the picture uncompressed. Most TIFF importing programs support this.

• PackBits (RLE)
The packbits algorithm is used for the compression. This works well on black & white
images.
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• LZW
The LZW algorithm is used. The results are often very good.

• LZW with Prediction
The LZW algorithm is used with prediction. The results are often better than without
prediction. Note: many applications do not support this scheme.

• Format
Select either Motorola (Mac) or Intel (DOS/Wintel) processors. Some DOS/Windows
applications can only handle TIFFs in Intel format ;-)

3.3.8.21 TGA Options
Options:

• No Compression
The picture will be saved uncompressed.

• RLE
The picture will be saved using RLE compression.

3.3.8.22 WMF Options
Options:

• No Compression
The picture will be saved uncompressed.

• RLE
The picture will be saved using RLE compression.

 
3.3.8.23 XBM Options
Options:
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• Version
Select the release version for the XBM file.

3.3.9 Save a Copy as
Saves a copy of the active window with a new name. GraphicConverter will remember
the original file format.
3.3.10 Revert
Reverts to the previously saved version of the active window.
3.3.11 Aquire
This submenu contains all „acquire“ plug-ins contained in the plug-in folder, used for
scanning or import of digital images from a digital device. GraphicConverter supports
most Photoshop 2.5 compatible plug-ins and installed twain plug-ins.

3.3.11.1 TWAIN Aquire
Opens the with TWAIN Open Source selected aquire plug-in for retrieving the image
data.

3.3.11.2 TWAIN Open Source
Opens a dialog for selecting the TWAIN data source. The dialog displays all installed
TWAIN devices.
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Press command and I to get information about the selected data source.
3.3.12 Export
This submenu contains all „export“ plug-ins contained in the plug-in folder, used for
exporting special formats. GraphicConverter supports most Photoshop 2.5 compatible
plug-ins.
3.3.13 Edit File Info (IPTC)
Displays a dialog to set the file information according to the IPTC standard, which is the
standard for the printing industry. It contains file information for description, author,
keywords, time, location, etc.
3.3.14 Edit Color Profile
Displays a dialog to set the source and printer profiles. In this dialog you can enable
colorsync matching of the image colors when opening an image. GraphicConverter
supports ColorSync 2.6.1 or later. You can download the latest version of ColorSync
from http://www.apple.com.

3.3.15 Slide Show
Choose a folder or one file in a folder. GraphicConverter then displays all pictures in
that folder against a user defined background.

There is an optional  toolbox display in the slideshow (the option is in the preferences).
The usage of the symbols is as follows:

Go to the previous picture.

Go to the next picture.

Stop the slideshow.

Pause the slideshow.

Move the current picture to the trash.

http://www.apple.com
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Create an alias of the current picture. Alias folder settings are in the
preferences.

Rename the current picture.

More shortcuts:
command-period cancel slideshow
command-M create an alias
command-R rename the current picture
command-backspace delete the current picture
command-1 ... 0 move the picture to the move folder (prefs)
space go to the next picture
cursor right go to the next picture
cursor left go to the previous picture
cursor up pause the slideshow

3.3.16 Slide Show with Find
Invoke by holding Option when opening the File menu and selecting Slide Show. This
function is useful for scanning a complete volume for files whose name contains a
particular string or has a specific file type and/or creator.
Dialog box:

• Volume
Select the volume for the search.

• Partial Name
Enter part or all of the name. Leave blank to ignore this term in the search.

• Type
Enter the file type. Enter **** to ignore the file type.

• Creator
Enter the file creator. Enter **** to ignore the file creator.
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Click on OK to view all files that match.
3.3.17 Continue Slide Show
NOTE: This option operates without notification. Invoke it by holding Shift when
opening the File menu and selecting Slide Show. It will continuously display the last
slideshow.

3.3.18 Convert…
Use this to convert or copy more files, just like the standard file dialog.  The source files
appear on the left and the destination folders appear on the right.

• Left hand list
Select the source files.

• Filter popup menu
Use to filter the source files.

• Right hand list
Select the destination folder. Convert cannot save to the desktop folder.

• Format
Select the destination format.
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• Options…
Additional options for some formats.

• Convert
Converts all selected files/folders in the source list to the destination list.

• Copy
Copies all selected files/folders in the source list to the destination list.

• Convert Text
Converts by text all selected files/folders in the source list to the destination list.

• Icon/Preview
Generates a preview for all selected files in the source list.

• Superpalette
Calculates the best matching 256 colors for all selected files and creates a color table
file. Use this file during „Batch“ for color reduction (see below).

• Lowercase
Renames all selected filenames to lowercase text.

• Rename
Renames all selected files following to the settings of the next dialog.

• Concat
Concats the source files to one large file. You define the number of columns and
rows.

• Insert IPTC
Inserts IPTC information from a text file into the selected files.

• Batch…
Sets batch functions for the conversion process. This feature is only available in the
registered version. The batch button is marked when there are any batch actions set.

• Arrow
Reverses the conversion path (left-to-right, or right-to-left).

• Resizing
You can resize the window using the grow box in the bottom right corner of the
dialog.

• Explanations for the other buttons follow in the following sections.
Hint:
If you convert a GEM-Metafile, WPG or CGM into a PICT, the PICT contains the original
vector information.

3.3.18.1 Catalog
Creates pictures with previews of the selected files. Catalogs can be created in either
PICT format or in HTML format. HTML format catalogs can be directly uploaded to a
web server. The pages contain the links to the images and first/previous/next/last links
to the other pages.
Catalog settings are defined in the four tabs of the dialog.
General
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• Picture details
You define the total size of the picture or web page.

• Thumbnail details
You define the thumbnail size and the display of the additional details like name and
file size.

• Picture count
GraphicConverter calculates depending on the settings the number of thumbnails in
each row and column.
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File

• Name
Filename of the catalog.

• Format
File format of the catalog. HTML and PICT are available. Click on JPEG Quality to set
the quality of the thumbnails in HTML catalogs.

• Creator
File creator of the catalog file. The Finder uses the assigned application for opening if
you double click on such a file. You can click on Set to choose an application.
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HTML Basic

• Picture frame
Check this if the thumbnails should be displayed with a border. GraphicConverter
will add the HTML command border=0 if you uncheck this option.

• Add tabs to HTML
Check this if you want the HTML code to be more readable.

• <TD>..</TD>  in one row
Check this if you want the HTML code to be more compact.

• Create “images” folder
Check this if GraphicConverter should create subfolders for the picture files.

• Thumbnail path
Relative path to the thumbnail folder.

• Picture path
Relative path to the picture folder.

• HLINK
Enter the color for HLINKs in HTML notation if you do not want to use the default
color.

• VLINK
Enter the color for VLINKs in HTML notation if you do not want to use the default
color.

• Make filenames lowercase
Check this option to avoid problems with some web servers.
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HTML Meta

• Allow search site to build an index
Check this if you want to make you catalog available for search engines.

• Author
Enter the author name.

• Description
Enter the description for the complete catalog.

• Language
Enter the language of your description and keywords (en=English, de=German,
fr=French).

• Keywords
Enter the keywords separated by a space for the complete catalog.
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3.3.18.2 Rename
Dialog window for renaming selected files.
Use to change the creation date, index, etc.
GraphicConverter will apply all checked entry on each selected filename in your list.

Examples:

Add index with offset 100, digits 4 and before name will do the following:
a.tiff -> 0100a.tiff
b.tiff -> 0101b.tiff
c.tiff -> 0102c.tiff

Change Name and Change Extension will change this parts of the name.

Add Date will insert the file date into the name or extension following to your settings.

3.3.18.3 Concat
Use this function to concatenate a group of small images to one large image. You can set
the number of vertical and horizontal tiles in the dialog that appears upon clicking on
the Concat button. The result is one file with multiple images in it.
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Click on OK and all source images will be concatenated and saved in the selected file
format.

3.3.18.4 Insert IPTC
Use to set the IPTC information in JPEGs from a text file. The text file may be exported
from a database. The text file and the JPEGs must be in the same folder. Select the text
file and click on Insert IPTC.
The format of the text file must be:
• File name (without path)<tab>
• Caption<tab>
• Caption Writer<tab>
• Headline<tab>
• Special Instructions<tab>
• By Line<tab>
• By Line Titel<tab>
• Credit<tab>
• Source<tab>
• Object Name<tab>
• Date Created<tab>  Attention: format yyyy.mm.dd (year.month.day)
• City<tab>
• State<tab>
• Country<tab>
• Reference<tab>
• Category<tab>
• Sub Category<tab> Separate multiple words with spaces
• Urgency<tab> Attention: number
• Keywords<tab> Separate multiple words with spaces
• Copyright<return>
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3.3.18.5 Batch
Use to apply functions to all documents selected to be converted.
Displays the following dialog:

Options in the dialog:
1. Right hand list

Displays the available functions. Select an entry and click on Add.
2. Left hand list

Displays the selected batch functions for this batch. The functions will be executed in
this order. Click on any entry for editing. Click on Delete to remove an entry.
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3.3.18.6 Prefs of Convert More

Convert Text

• Convert Text
Select the source and destination format for the text conversion. GraphicConverter
will convert the line end characters and the special characters such as ä, ö, ü, ß.

Icon/Preview

• Icon/Preview
Creates icons and previews only when they not exist.

Errors

• Error
Shows an alert after each error or writes an error log file (GraphicConverter
protocol) to the desktop.
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Misc

• Subfolders
Allows conversion of all files of selected folders including those in subfolders.

• Change Extension
Allows you to add the extension of the new format to the file name (i.e. „.TIFF“).

• DOS File names
Use to shorten the file names to “8.3” (eight characters plus 3 extension characters).

• Don‘t alter before overwrite
You either see or don’t see a warning dialog before overwriting.

• Compress with StuffIt
Allows compression of files with StuffIt (if the engine is available).

• Show hidden Files
Shows any hidden files in the file list of Convert.

• Remove batch actions after quit
Clears the Batch  Table after quitting the application.

Index
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• Index Conversion
Changes the index (if available) of a file to the minimum number of entered digits.
The File „Test.1.PIC“ will be converted to „Test.00001.PIC“.

• Index Sorting
Sorts the files in the „Convert more“ dialog by the index (i.e. „1, 2, 3, 4, 5, 6, 7, 8, 9,
10…“ and not as normal „1, 10, 2, 3…“). This is useful for conversion of single images
to QuickTime movies.

• Use Name
Renames every file with the new name.

• Start Index
Adds an index to every file starting with the start index.

3.3.19 Page Setup
Sets the format and quality of printing.
3.3.20 Print
GraphicConverter prints the contents of the active window. If you print a picture,
GraphicConverter adds some fields to the standard print dialog.
These fields appear in the LaserWriter print dialog if you select GraphicConverter in the
popup menu. The extra fields may also appear in the main print dialog of other printer
drivers.

• Area
Prints the complete picture or only the visible part.

• Size
Change the print size with these options.

• Print Display Information
Prints the picture size, name, depth etc., at the top of the page.

• Behavior
You indicate what to do if the file exceeds the page boundaries.
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• Position
Sets the position of the image on the page. You can use this option if you print little
images on high quality paper, this reducing paper costs

• Margins
Sets the printing margins.

• Smart Trim
Trims the image before printing.

• Smart print orientation
Rotates the image depending on the orientation.

3.3.21 Print Catalog
Selecting “Print Catalog” will produce a printed copy of ALL the pictures in the selected
folder. The catalog displays every picture with its name and size. Additionally, the full
path is shown at the top of the page, and the page number at the bottom. Set the
margins and page offset with the menu selection ‘Preferences’.
1. Choose the folder.
2. The print dialog box will be displayed for you to select the print options.

Mode: Arrange pictures depending on resolution:
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The number of photos per row and the number of rows will be selected by the
program, taking into account the size of the picture.
By selecting the resolution in the dialog box that is part of the printer driver, the user
can select how many pictures appear per page.  The LOWER the resolution,  the larger
the pictures will be.  Selecting 600 dpi will produce about 30 or so pictures per page,
each quite small.  Selecting 100 dpi will produce about 6 pictures per page,  each about 3
x 2.5 inches if the pictures are from a 960x720 digital camera and saved in jpeg format.
Printed on a 600 dpi printer the above settings give quite good resolution.   If one of the
pictures should be larger,  say 2250x2250,  it will appear by itself on one of the pages.
Each picture will have printed below it whatever name is used to identify it in the folder.
The path to the folder will be printed at the top of each numbered page.

Mode: Arrange pictures with fixed size:
You set the number of pictures per row and column.

Using the "Print Catalog" is a good, quick way to produce an album of pictures.
All pictures are arranged neatly on the page, and each is identified so you can find it in
your files.  There is also room for additional comments.
3.3.22 Print Folder
This command prints the documents of a complete folder on separate pages. Please
refer to the settings for each document to the standard print command.
3.3.23 Quit
Exits GraphicConverter.
GraphicConverter saves your Preferences changes automatically.
This item is with MacOS X under the GraphicConverter menu.
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3.4 Edit Menu
This menu provides functions for editing pictures and transferring them into other
applications.

3.4.1 Undo
Undoes the last action in the active window. If undo is enabled, it will appear
highlighted in the menu.
3.4.2 Cut
Copies the contents of the selection in the active window to the clipboard and deletes
the contents from the active window.
3.4.3 Copy
The copy menu contains a submenu with all copy functions. You can simple release the
mouse on this menu item if you want to do a normal copy call.
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3.4.3.1 Copy
Copies the contents of the selection in the active window to the clipboard.
3.4.3.2 Copy as HTML
Press the control key when pulling down the Edit menu to see this item. This displays a
dialog to specify the settings for “Copy as HTML”.
The IMG tag will be built according to the settings in this dialog.
Example:

<IMG SRC="images/sample.gif" WIDTH=393 HEIGHT=234>

3.4.3.3 Copy as HTML Options
Press the control key to get this option.
This brings up a dialog to specify the settings for „Copy as HTML“.

The IMG tag will be build depending on the settings in this dialog.
3.4.3.4 Copy as
Allows you to specify the copy options for the selection.
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You can set the size, scale or resolution in the dialog.
Note:
This function is useful for copying the selection with the correct size and the original
resolution (you lose no data or resolution).
3.4.3.5 Copy EXIF as TEXT
Places the EXIF information (if available) as text in the clipboard
3.4.3.6 Copy as X-Face
Places the current image in the X-Face format in the clipboard
3.4.4 Paste
The paste menu contains a submenu with all paste functions. You can simple release the
mouse on this menu item if you want to do a normal paste call.

3.4.4.1 Paste
If a PICT is on the clipboard, then the program inserts it in the active window. If you
press the option key before pulling down the Edit menu, Paste changes to “Paste at
Location…”. You will then see a dialog to enter the coordinates for the clipping.
3.4.4.2 Paste at Position
Displays a dialog to define the position for pasting.
3.4.4.3 Paste Frame
Paste the content of the clipboard as a new frame in an animation.
3.4.5 Clear
The clear menu contains a submenu with all clear functions. You can simple release the
mouse on this menu item if you want to do a normal clear call.

3.4.5.1 Clear
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Deletes the contents of the selection in the active window.
3.4.5.2 Clear Frame
Deletes the current frame of an animation.
3.4.6 Find and Replace
Use this function to replace one color of an image with another color. You can define a
tolerance. This is used to replace similar search colors, too.

Allows selection of the source and destination color with the color picker or by clicking
in the image.
3.4.7 Select all
Selects the entire contents of the active window.
3.4.8 Select Picture Content
Selects only the contents of a picture and not the solid colored borders.
3.4.9 Invert Selection
Inverts the selection. This is usefull if you select an object with the magic pen and want
to remove the background image.
3.4.10 Unselect
Unselects the selection. You can use the escape key as a shortcut.
3.4.11 Fill Selection with Foreground Color
Fills the selection with the foreground color.
3.4.12 Trim
Cuts away the non-selected parts of a picture and leaves the selection as the result.
Note: This saves memory.
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3.4.13 Trim Options
Defines the trim options.

• Tolerance
Defines how tolerant the trim function should be, compared to the background color.

• Sides
Limits the trim operation to specific sides of the graphic. This may be useful when the
height or width of a graphic should remain the same.

 
3.4.14 Compare
Compares pictures. This is especially useful to find the differences between the original
and the JPEG compressed file. The function creates a new window with the differences.

• Intensity
Use this factor to scale the value of the difference. This is helpful to make small
differences more visible.

• Compare
Check the first file.

• With
Check the second file (the width, height and bit depth must be the same as the first
file).

3.4.15 Next Page
This will display the next page of a multipage document.



56

3.4.16 Previous Page
This will display the previous page of a multipage document.
3.4.17 Goto Page
This will display a dialog to move to a page of a multipage document.
3.4.18 Enable/Disable Grid
You enable or disable the grid.
3.4.19 Grid
You get a dialog to define a grid.  You can set the grid dimensions for the x- and y-axis.

The grid is used by the drawing functions.
3.4.20 Clipboard
Shows the contents of the clipboard.
3.4.21 Preferences
This dialog contains settings and options for all parts of GraphicConverter. The left tabs
display the category. Depending on the selected tab, additional tabs will appear at the
top of the dialog window.
This item is in the GraphicConverter menu under MacOS X or later.
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3.4.21.1 General

Display Windows Settings

• Toolbox
The toolbox is displayed automatically upon opening or creating a picture.

• Information
Displays the information window upon opening or creating a picture.

• Position
Upon opening or creating a picture, this will display a small window at the top right
of the main window. This window displays the mouse position in the main window.

• Comments
Upon opening or creating a picture, this will display a small window at the bottom
right of the main window. This window displays the comments of the pictures (if
there are comments in the file).

• Movie Options
Displays a small window with the movie options.

• Overview
Displays a small window with the content of the picture as a thumbnail.

• Detail
Displays a small window with the region under the cursor enlarged. You set the
default scaling in the edit field.

• Toolbars follow picture
Automatically repositions all tool windows after a move or resizing of the image
window.

• Fixed positions
Opens the tool window at the same position where it was last left.

• Auto-arrange
Arranges all windows on opening as set in the „Arrange…“ menu command.

• Open only one window
Check this to show only one window. GraphicConverter will automatically close all
open windows when you open a new file.

• Show path in title
Displays the complete path of the opened image in the title of the window.
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Display Windows Settings

• WYSIWYG
GraphicConverter opens every file in WYSIWYG resolution.

• Everytime 100%
Every window will be opened at 100%. This is true even if the resolution of the
picture is different from that of the screen.

• Fit to Screen
Rescales every image to the full area of the screen.

• User defined
Allows you to set the default scaling.

• Maximum Size
Will open the picture at the maximum size.

• Anti-Aliasing
Allows the Mac to dither pictures even if they’re not the original size. It produces a
better view, but slows down the computer.
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Monitor
This option is available only on a Mac which has two or more connected monitors.

• Picture
Simple set the default monitor for the windows by drag and drop of the picture.

Edit

• Dither
Set if GraphicConverter should dither the clipboard.

• Select existing
Set an additional margin for selections.

• Selection
Set the method for handling the selection.

• Reposition Windows after Change
• Drag selection translucent

Uncheck this option if you have a slow Power PC.
• Use selected Colors for all open Images

You set the current foreground and background color for all images.
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Print
GraphicConverter uses these options for printing pictures and catalogs.

• Margins
Sets the margins of the page.

• Print Time Stamp
Prints the current date on the background (works only on Postscript printers).

• Show print dialog during Finder printing
Check this option to display a print dialog from the Finder for every print command.

Memory

• Undo available
Undo slows down the application somewhat. But it gives you the option to undo
most functions.

Plug-ins
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GraphicConverter versions 1.7.9 or later allow the use of Plug-ins. The user can
program special import and export filters. Version 2.3 or later can use PhotoShop filter
plug-ins. The plug-in developer kit is available online at http://www.lemkesoft.de and
http://www.lemkesoft.com.

• Set Folder
You define the folder that contains the plug-ins.

• Support Aquire again
Check or uncheck this options if aquire does not work correctly.

• Close TWAIN Source
Check or uncheck this options if aquire does not work correctly.

• Support old Plug-ins
Check this option if a plug-in does not work.

• Ask TWAIN driver for color table
Check this option if you scanner driver returns a color table for 8 bit images

http://www.lemkesoft.de
http://www.lemkesoft.com
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General

• Dimension
Sets the dimension to centimeters or inches for margin values.

• Show Startup Dialog
Unchecking this disables the startup dialog. This is only available in the registered
version.

• User Interface
You get a simpler user interface without an edit function when you select Less
Complex.

• Fast Sorting
Check this box for faster sorting. It will improve the speed for large file lists by a
factor of 5 to 10. NOTE: This option is only useful for roman fonts because the fast
sorting routine do not work with Japanese, Arabic etc.

• Use Navigation Services
You enable or disable the use of the new Navigation Services under MacOS 8.5 or
later.

• Use Zoom Effects
Enables the nice zoom effects during opening and closing windows. Available with
MacOS 8.5 or later.

• Configure PC Exchange/File Exchange
Use this to configure PC Exchange/File Exchange. The Finder will then automatically
start GraphicConverter to view PC graphics (when they are selected or double-
clicked).
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3.4.21.2 Open

General

Correct Size
If one of the following three choices is selected, GraphicConverter resizes the picture:

• Change file type
GraphicConverter automatically sets the file type of a picture to its own upon loading
a file.

• Verify color table integrity
The color table of IBM-based pictures is often in the wrong order. You can get
problems with these PICTs while printing or performing other operations. If you
check this box you can fix those problems forever.

• Notify loss of information
GraphicConverter notifies you if you open an image with vector data.

• Correct aspect ratio
Check this option to automatically rescale files with different horizontal and vertical
resolutions. This may be useful for conversion of fax files to a format that does not
support differential resolutions (like GIF).

• Calculate best color table
GraphicConverter will calculate an optimized color table for 32 and 16 bit pictures
even if you display them in 8 bit.

• Show alert before opening files with same name
Displays an alert dialog before opening a window whose name already exists.

PICT

Format Source Pixels Destination Pixels
VGA (256 Colors) 320x200 320x240
EGA (16 Colors) 640x350 640x480
Atari (4 Colors) 640x200 640x400



64

• Big Color Test
Select the big color test if GraphicConverter opens a vector PICT without all colors.

• Scale Vectors
Whenever a PICT is opened, a dialog will appear to allow a change to the size and
resolution.

Metafile

• GEM-Metafile
Sets the relationship between GEM and Mac-fonts.

• Size of Metafile
Sets the maximum size of Metafiles.

• Calculate Minimal Size
Calculates only the part of the image which contains information. The file
information will be ignored. This saves memory.

• Font Scale
Allows correction of the size of fonts with this factor.

• Treat CGM
Switch this option if the imported CGM file looks not correct.
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HPGL

• Width
Allows you to set the default width in mm.

• Color
Sets the default color.

• Resolution of a unit
Sets the length of a unit in the HPGL file. This is normally 0.025 millimeters, but may
be changed here to reduce memory usage in large drawings.

• Resolution of the pixmap
Sets the resolution of the new pixmap. This is to provide scaling.

• Font
Sets the font for HPGL labels. You can change the font size with the scaling factor if
desired.

• Recognize IP and SC
Enables scaling with the SC/IP command.

• Coordinates
Enter the default paper size in plot coordinates.

• Default Rotation
Select the default rotation (required for buggy HPGL files).

Note
HP-GL/2 documents can change the pen width and color.
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Lotus-PIC

• Lotus-PIC
Defines the 16 colors of a Lotus-PIC file if GraphicConverter is to import the file in
color.

FITS

• FITS
FITS files use a range from 8 to 64 bit for the grays. Mac’s can only handle 8 bits of
gray (256 grays). Use this to set how to map the grays. This probability scheme often
gives better results.
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PCD

• PCD
Defines the standard open size. Check the „Show Dialog“ option to get a dialog on
every opening.

Using this dialog, you can open either a selection of, or a complete PCD. The dimension
may be set manually, or you may chose standard preset sizes.

Note: Open the PCD files directly from the folder PHOTO_CD:IMAGES on your photo
cd and not from the emulated folders!
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JPEG

• JPEG
Defines which library GraphicConverter uses for opening JPEGs. However,
QuickTime can’t decompress every JPEG, though it is faster than JPEG 6.0.
GraphicConverter will use JPEG 6.0 Libs automatically when QuickTime fails in
decompression.
Note: the QuickTime library may crash your system with corrupt JPEGs. JPEG 6.0 is
the recommended default.

• Remember EXIF block for resaving
Check this to save the original EXIF information of a JPEG from a digital camera back
to the JPEG.

• Display content of unknown tags
Use this to get additional informations in the comment window.

GIF

• GIF
The application ItsAGif creates gif animations to display gifs with more than 256
colors. Sometime GraphicConverter can decide if a file is an ItsAGif file or a normal
GIF animation. Check this option when you have any problems with the detection.

• Enlarge animated GIFs
Check this option for enlarging GIF animations that are saved with a wrong
maximum frame.

WMF
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• Ignore
Check this option if the WMF import is not correct.

QuickTime

• Use QuickTime graphic importer
QuickTime allows the import of some still graphic file formats. GraphicConverter will
use this option by default. But the QuickTime importer may crash your system with
some corrupt files.  Uncheck this option when you detect a problem.

EPSF

GraphicConverter can only open EPSF files by using a helper application. Supported
applications are Ghostscript (freeware; ftp://ftp.cs.wisc.edu/pub/ghost/aladdin/) and
EPStoPICT (shareware; http://www.artage.com ).
• Resolution

Sets the import resolution of the EPSF file. A high resolution may require a lot of
memory.

• Bit depth
Sets the bit depth of the image.

• Application
Specifies which application should be used.

• EPStoPICT settings
You will find a description of these options in the manual of EPStoPICT.

http://www.artage.com
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The first time you open an EPSF file, you will be ask for the location of the interpreter
with the following dialog box. Simply click Search and select the application. The EPSF
file will then be opened.

Movie

• FLH Color Encoding
The color information in FLH files may be stored in three kinds. There is no way to
detect which kind. Select the correct kind for your files here.

PSD (Photoshop/Photo Deluxe)

• Ask for layers
Select this option to get a dialog before opening a Photoshop image. You can select
the layers for importing. You have to check this option for importing Photo Deluxe
images correctly.

• Import only background
Imports only the background layer of a Photoshop image.

TIFF
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• Ignore interpretion value
Check this option if your TIFF files are inverted. This happens if the TIFFs writer set
this value incorrectly.

• Display content of unknown tags
Displays unknown tags in the comment window. This is useful for debugging a TIFF
image.
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3.4.21.3 Save

General

• Add Resource fork
Use to enable or disable the resource fork.  NOTE: Macintosh files can have a
resource fork. This part of the file contains additional information like preview, color
table, description etc. This part may enlarge the file significantly, and it is not required
for web page use.

• Create Custom Icon
GraphicConverter automatically builds a file icon with a small thumbnail of your
picture.

• Create Preview
GraphicConverter automatically creates a small preview in 16 bits (max. size 80 x 80
points, if you use QuickTime) of your picture. This is compatible with Quicktime
previews.
You can compress the previews with the JPEG mechanism. This will create a smaller
preview. But the display of the preview (for example in the browser) is much slower
than a uncompressed preview.

• Sharpen preview
Check this to enhance the preview quality a lot of.

• pnot with nil
Set this if a nil pointer should added to the preview info resource. Some applications
are incompatible with this.

• Info string
Set this if GraphicConverter should write the name „GraphicConverter“ as the
source application to the file.

• FLI to Movie
Check this box if you save FLIs or FLCs as a QuickTime movie in which you want the
first frame to shown again after the last.
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• Dest. File Format
Sets the default file format.

• Color Table
Adds a pltt or clut resource with the color table of the image to the file.

Custom Icons

• Add black Border
Check this to save the custom icon with the default black frame/border.

• Icon with Dog-Ear
The customized file icon will have a dog-ear if this box is checked.

• Create standard icon suite
Creates the standard custom icons that are required for display under MacOS 7.0 or
latter.

• Create new icon suite
Creates the new icon suite with 32 bit icons for MacOS 8.5 or later.

• Add huge icons
Creates also large 64x64 pixel icons.

Note:
Custom icons make the files larger!
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Settings

• Extension
GraphicConverter automatically adds a format extension, i.e., PICT to your picture
name if you use Save as. Additionally you can set the form of the extension.

• Width while Saving
Clip PICTs to the original width with this option.

• Path
Enter the source path of the image as the default path. NOTE: not compatible with
Directory Assistance II.

• File Type
Enter the creator of the file when saving.
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3.4.21.4 Slide Show

General

• Display Name
Displays the name of the current picture in the top left corner of the screen.

• With Path
Displays the path in addition to the name.

• Blow up small Pictures
Resizes small pictures to the full screen size.

• Display Errors
Errors occuring in the slide show will be displayed.

• Info on second monitor
Displays information about a picture on a second monitor.

• Display Comments
Displays the file comments under the image in the slide show.

• Effects
Select the effect for the slideshow image display.

• Sort
Sorts a slide show alphabetically by name or date. NOTE: very slow for big folders.

• Subfolder
The slide show will display pictures found in any subfolder of the selected folder (up
to the depth defined here).

• Alias
Sets the destination folder for alias files that you create during the slide show.

• Show tool icons
Displays a small toolbox during the Slide Show. Used to navigate within a slide
presentation.
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Misc

• Endless
Automatically loops back to the first picture following the last.

• Minimal Showtime
Sets the minimal time the picture appears.

• Font
Selects the font for the picture title.

• Color
Selects the background color.

• Change Picture
The Slide Show changes the picture after the set display time or after a mouse click or
arrow keystroke.

• Ignore
Defines the file extensions that will be ignored.
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Move Folder
The Slide Show has an option to move a file to a defined folder (i.e. for sorting) by
touching command-1 to 0.

• Folder
Click on the „Set Folder ..“ button to define a folder with a file dialog.
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3.4.21.5 Browser

General

• Sort
Selects the default sorting criteria.

• Descending order
Sets the default sorting direction to “Top Down”

• Separate Folder
Displays the folders first and than the files.

• Create Preview automatically
Creates a preview automatically for every file which has none.

• Enlarge small ones
Displays small previews enlarged.

• Create log
Creates a log file on the desktop with messages generated during Browser
operations.

Display
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You define with details should be displayed in the browser.

Misc

• Select default “Open with” application
Lets you set the default application for opening files from the browser with another
application with the shortcut Shift + Command + O.

• Redirect double click to Finder
Check this option if the Finder should open the files in the browser with the
application that created the files.

• Show path in window title
Check this to see the complete folder path in the title of the window.

• Open folders in same browser
Check this option to open a folder (after a double click on a folder in the browser) in
the same browser.
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• Use lossless JPEG rotation
Check this to rotate JPEGs losslessly. This is a bit slower than lossy rotation. You can
speed up the rotation by assigning 20MB or more to GraphicConverter.

• Drag&Drop handling
Select the Drag&Drop  behavior.

• Ignore
Indicate the file extensions to be ignored. This speeds up the display of the graphics
files.
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3.5 Picture Menu
The Picture menu allows you to adjust the contents of a picture.

3.5.1 Information
A small window giving details about the picture appears in the lower left corner of the
screen.
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The IMAGE tab of this dialog displays information about the file, such as size,
resolution, format, etc. The other 2 tabs display the additional EXIF (digital camera
details) if available.
3.5.2 Toolbox
Displays a new window with drawing tools. See also ‘Toolbox’ in Chapter 4.
3.5.3 Position
Displays a new small window at the top right of the picture window. It displays the
cursor position within the picture area.

This window will show the width and height of selections during opening a selection.
Also, it will display the color under the mouse if you use the color picker tool.
You can set the origian (base point) of the coordinates very easy. Simple click in the
coodinate window and click than on the new base point in your window.
3.5.4 Comments
The contents of the comment window will be saved to the resource fork of the graphic
file as a ‘TEXT’ resource when the option “Add Resource Fork” is checked in the
General Settings of the Save preferences.

Click in the arrow symbol to select another font for the comment window.
3.5.5 Overview
Displays a new, small window at the top right of the picture window. It displays the
complete image in miniature and within it a rectangle showing the currently visible
region.
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You can drag this rectangle to view any part of the picture.
3.5.6 Detail
Displays a new, small window at the bottom right of the picture window. It displays a
magnified area around the cursor. You can set the zoom factor by clicking on the + and
- buttons inside this window. The current zoom factor is displayed next to the symbols.
This window can be very helpful when editing fine items.

3.5.7 Movie Options
Displays a new small window with the movie options. You can edit the options for
every frame of a GIF animation with this window.
3.5.8 Zoom
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3.5.8.1 Size
If you choose a percentage value, the window is resized accordingly. Alternatively, if
you choose the “View as Proportional / Non Proportional” items a dialog is displayed
to set the percentage or the size respectively. The submenus contain functions for
physical resizing of the picture.
3.5.8.2 Zoom Selection
Zooms the selection so that the selection fits the actual window size.
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3.5.9 Size

3.5.9.1 Add/Remove Margins
Displays a dialog to add margins to or subtract margins from the picture. Type negative
numbers to subtract margins. The resulting pixel size of the image is displayed in the
center of the dialog.
The additional margins are added with the current background color.
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3.5.9.2 Scale
Displays a dialog to scale the picture. You can scale with a factor or size. Proportional
scaling is also available.

3.5.9.3 Burn in
Copies the picture in the changed size into a new bitmap.
Note: Undo is not possible!
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3.5.10 Resolution
Use this function to change the real or virtual resolution of the image. Check the
“Convert picture” option to change the actual number of pixels.

3.5.11 Brightness/Contrast
Use this function to change the brightness, contrast, hue and/or saturation of an image.
There will be fewer options for grayscale images.
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The Picture window shows the complete picture. The inset preview rectangle may be
repositioned to change the region displayed in the “Before” and “After” windows. The
“Before” window shows the original picture and the “After” window the altered
picture. Check “Full Screen Preview” to see the change on the image window itself. But
this may slow down the change a lot of.
3.5.12 Levels
Use this function to change the levels of the image.

The Picture window shows the complete picture. The inset preview rectangle may be
repositioned to change the region displayed in the “Before” and “After” windows. The
“Before” window shows the original picture and the “After” window the altered
picture. Check “Full Screen Preview” to see the change on the image window itself. But
this may slow down the change a lot of.
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3.5.13 Mode
You can change the mode of the image with this submenu.
3.5.14 Colors
This submenu contains all functions for editing the color table and changing the color
depth of the image.

3.5.14.1 Grayscale
Changes the color table to a grayscale color table. If the picture is true color (16 or 32
bit), an additional sub-menu is enabled, allowing the selection of the number of values
in the grayscale (4, 16, 256).
3.5.14.2 Dither
Enables or disables dithering for grayscale conversion.
3.5.14.3 Edit Color Table
Displays a dialog for editing the individual colors of the color table.
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Clicking the plus or minus buttons next to the numbers increments or decrements the
value. Note: The colors of pictures range from a depth of 1 to 8 bits.

3.5.14.4 Sort Color Table
Sorts the color table.
3.5.14.5 Apple-like Color Table
Sorts the color table to conform with Apple conventions (index 0 being white and the
highest index being black).
3.5.14.6 Minimize Color Table
Reduces the picture depth if not all colors are in use.
3.5.14.7 Change Depth Dynamically
Use this function to reduce the number of colors dynamically between 2 and 256 colors.
This maybe useful for optimizing images for the WWW usage.
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This is useful for preparing GIFs for the internet, as the GIF format allows 2, 4, 8, 16, 32,
64, 128 and 256 colors. Choosing fewer colors reduces the file size dramatically at the
expense of quality.
3.5.14.8 Change Depth
Changes the color depth of the picture. When reducing the color depth, use the Median
Cut algorithm to calculate the best palette and color dither for best results.
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3.5.14.9 Options For Color Reduction
You define the color table for the reduction of images to 256 or less colors with this
dialog.

• Allows choice between the system color tables and optimized color tables.
3.5.14.10 Swap Colors
You can swap two colors of an image with this option. This is very useful if you want to
save your image in a special file format. The KISS CEL format defines the color 0 as
transparent. So, you can swap the transparent color with the color 0 if you want to save
an image in this format.
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3.5.15 Invert
Inverts the data of either the picture or the selection, in the active window.
3.5.16 Rotate

3.5.16.1 Fixed Degrees 90 left, 180, 90 right
Rotates the picture or selection with the selected value.
3.5.16.2 Other Value with Line
You can rotate the image with a helper line. This is very useful for photographics.
Simply select the function. Click in the image and draw a line on a horizontal or vertical
border. The sample image shows the results before and after the rotation.

3.5.16.3 Other Value
Rotates the image with the entered value.
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• Error Correction
Smoothes edges during rotation. (Only 32 bit images)

• Add Alpha Channel
Adds an alpha channel. (Only 32 bit images)

3.5.17 Mirror
Flips the picture (horizontally or vertically).

3.5.18 Median
Opens a dialog for the application of a median filter to the image. The Picture window
shows the complete picture. The inset preview rectangle may be repositioned to change
the region displayed in the Before and After windows. The Before window shows the
original picture and the After window the altered picture.
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3.5.19 Pixmap Information
Displays a dialog with information about the width, height, depth, colors, resolution and
size of the actual pixmap, or about the selection - if there is one.

3.5.20 Histogram
Displays a dialog with the intensity histogram of the picture.
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3.5.21 Full Screen
Displays the picture in front of a black background.
3.5.22 Play
Plays a ‘film’ in front of a black background - if one is in the active window.
3.5.23 Put Picture on Desktop
Sets the image as the desktop picture of the main monitor screen. This function works
with MacOS 8.5 or later.
3.5.24 Put picture to Décor
This item is only active if Décor is installed. Décor is a system extension that can put a
picture on the desktop (similar to the Desktop Pictures in OS8).
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3.6 Effect Menu
The Effect Menu contains special functions for working with color pictures.

3.6.1 Floyd-Steinberg
Converts the picture using the Floyd-Steinberg algorithm into a black and white picture
with the same size.
Note: This generates a new picture without changing the original.
3.6.2 Ordered-Dither
Displays a sub-menu to select the matrix area (2x2, 4x4 or 6x6). GraphicConverter
dithers the picture with the selected size. Note: This will generate a new picture without
changing the original.
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3.6.3 Threshold

Converts the picture directly to a black & white picture. Every pixel value in the original
that has a level lower than the threshold value will be made black in the destination
picture.
Usage:
• Drag the preview rectangle with the mouse in the Picture window to define the

preview region.
• Enter the threshold value or move the slider.
• The “After” field will be updated 3 seconds after the last numeric input or

immediately when the slider is moved. The picture will then be converted to 32 bit
(unless it is an 8 bit grayscale).
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3.6.4 Dither
Options for dithering:

Allows a color picture to be printed on a black and white printer with a higher
resolution than the monitor.

Notes:
• If printing a 72 dpi picture with a 300 dpi printer, use a 4x4 matrix for dither.
• Generates a new picture and doesn’t change the original.
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3.6.5 Gamma Correction
Options for setting the gamma correction value:

Corrects the gamma value of images from other systems or scanners.
Usage:
• Drag the preview rectangle with the mouse in the Picture window to define the

preview region.
• Enter the gamma value or move the slider.
• The “After” field will be updated 3 seconds after the last numeric input or

immediately when the slider is moved. The picture will then be converted to 32 bit
(unless it is an 8 bit grayscale).
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3.6.6 Unsharp Mask
Use this function to sharpen an image with as much as possible flexibility.

3.6.7 Sharpen Edges
Options for setting the percentage values for edge enhancement.
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Usage:
• In the picture field, move the preview rectangle with the mouse to define the

preview region.
• Enter the percent value or move the slider.
• The „After“ field will be updated 3 seconds after the last input or immediately when

the slider is moved. The picture will be converted to 32 bit (unless it is an 8 bit
grayscale picture).

3.6.8 Plug-In Filter
Gets a list of plug-in filters.
Additional filters may be added by adding text files to the plug-in folder (defined in the
preferences).
The file format is very simple. The content of a simple mean (5x5) filter is:

1 1 1 1 1
1 1 1 1 1
1 1 1 1 1
1 1 1 1 1
1 1 1 1 1

The dimension of such filters may be up to 100x100.
Recommendation: first convert the picture to 32 bit.
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3.6.9 User Defined Filter
Displays a dialog to define your own 3x3 filter matrix.

Usage:
• Drag the preview rectangle with the mouse in the Picture window to define the

preview region.
• Enter the values in the matrix.
• The “After” field will be updated 3 seconds after the last numeric input. The picture

will be converted to 32 bit (unless it is an 8 bit grayscale).
3.6.10 Color Permutation
Analogous to the transposition in music (which changes the key of a composition
according to certain rules without essentially changing the piece of music itself),
chromatic involution changes the colors of a picture according to certain rules without
essentially changing the harmony of colors of the picture itself. In the same way as the
transposing of keys leaves the intervals between the keys unchanged, chromatic
involution does not change the “contrast intervals” between the colors.
3.6.10.1 Chromatic involution
In analogy to the transposition in music (which changes the keys of a piece of music
according to certain rules without essential changing the piece of music itself), chromatic
involution changes the colors of a painting according to certain rules without essentially
changing the harmony of colors of the painting itself.In the same way as the
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transposing of keys leaves the intervals between the keys unchanged, chromatic
involution does not change the "contrast intervals" between the colors.
The contrast intervals in colors refer to
• Differences in the brightness of colors

51. Differences in angle on the circle of colors
52. Differences in the saturation of colors.

For more details refer to:   http://math1.uibk.ac.at/~liedl/
Chromatic involution is of particular interest for artists, scientists
of art, and perception psychologists.
3.6.10.2 Color rotation by 15 degrees clockwise
With this color permutation, all the colors of a painting are shifted "clockwise" by 15
degrees on the circle of colors. By repeated application of this order one can produce
further rotations.
3.6.10.3 Centric involution
Centric involution is the same as color rotation by  180 degrees. The Hue of colors is
transformed into its complementary Hue, but  S and V are maintained. Centric
involution does therefore not mean inverting (=color negative).
3.6.10.4 Cold-warm involution
The cold-warm involution is very similar to the chromatic involution. However,
originating from yellow-violet, the involution axis is slightly twisted in clockwise
direction. Warm colors turn into cold colors and cold colors turn into warm colors.
Yellow-green an lilac colors remain unchanged.
3.6.10.5 Isothermal involution
Isothermal involution turns warm into warm colors and cold colors into cold colors
again. Orange-red and turquoise  colors remain unchanged. Yellow-green colors are,
however, exchanged for lilac colors.
Involution around the red-green axis
In case of involution around the red-green axis, yellow and violet are exchanged for
each other, whereas red and turquoise colors remain unchanged.
3.6.11 Vectorize
Converts the picture in the active window into vectors. First you see a standard file
dialog to set the new filename. Next, you can switch between HPGL and PICT output.
After that the program starts vectorizing.
3.6.12 Show/Hide Alpha Channel
Shows or hides the alpha channel of 32 bit images.
3.6.13 Add/Remove Alpha Channel
Adds or removes an alpha channel. This works only with 32 bit images.
3.6.14 Alpha Channel to Picture
Copies the alpha channel into the picture. This deletes the content of the picture!
3.6.15 Even Field
Eliminates all odd lines for uninterlacing.
3.6.16 Odd Field
Eliminates all even lines for uninterlacing.
3.6.17 Overlay Grid

http://math1.uibk.ac.at/~liedl/
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Use this function to insert a visible grid into the image. The grid will be drawn with the
selected line width and color.
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3.7 Special Menu
The Special menu contains additional functions.

3.7.1 Layout Options
Displays a dialog for changing the parameters of the layout, which is described in detail
in Chapter 6:
- Typeface: choose the font name, size, and style
- Show Picture Name: checking this tells GraphicConverter to display the name of a
picture, right below the picture itself, using the selected font attributes.
- either display the picture or just a placeholder
3.7.2 Open List Window
If you close a list-window, you can reopen it with this function.
3.7.3 List Option
Displays a dialog for changing the parameters of the list:
- font, size and style
- margins
3.7.4 Copy File into Resource
Copies the data fork of a file into the resource fork of another file:
1. Select the source file.
2. Select the destination file.
3. Select the new resource type.
3.7.5 Invert Black & White GIFs
Inverts all Black & White GIFs of a folder.
Note: This function is included because B/W-GIFs from an PC are often inverted.
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3.8 Window Menu
The Window Menu allows you to arrange and select windows.

3.8.1 Minimute Window
Minimized the frontmost window.
3.8.2 Bring all to front
Activates all windows from the dock to the desktop.
3.8.3 Arrange
Arranges all windows as depicted in the icon.
3.8.4 Cycle Windows
Cycles through all open windows.
3.8.5 Window Names
Brings the window with the selected name to the top.
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3.9 Script Menu
The script menu displays all scripts from the script folder (only availabe in the PowerPC
version). You can press the option key to edit the selected script.

You open the script folder by selecting “Open Script Folder...”.
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4 Editing Tools
This chapter provides a brief description of the tools for editing a picture.
Many of the tools in the Toolbox may be modified by settings in a supplementary
dialog box. Tools with this functionality are indicated with a small, red triangle in the
tool button. If the tool is already selected, a single click on it will display the dialog. For
unselected tools, double-click the button.)
Toolbox
4.1 Lasso Selection

Use this tool to select and move a non-rectangular selection. Double click on the
symbol to get a dialog.
You can define the transparent color for copying by entering an index, selecting the
color in the color table, clicking in the picture or clicking on Set Back Color button. Save
To Preferences uses these settings for any future selection.

4.2 Select

Use this tool to select or move a rectangular selection. Double click on the symbol
to get a dialog.
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Special keys and function:
• Command-option-shift-click-drag in the selection

Moves only the frame without the content. You can use this function to define an
area with a fixed size.

• Command-click-drag on the handles (a small “+” symbol will be displayed next to
the cursor)
Scales the selection.

• Escape key
Deselects the selection.

You can define the transparent color for copying by entering an index, selecting the
color in the color table or clicking in the picture or by clicking on Set Back Color.
Save To Preferences uses these settings for any future selection.
Also, you can enter or change the size of the selection.
4.3 Round Selection

Use this tool to select and move a round selection. Double click on the symbol to
get a dialog.
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You can define the transparent color for copying by entering an index, selecting the
color in the color table, clicking in the picture or clicking on Set Back Color button. Save
To Preferences uses these settings for any future selection.

4.4 Magic Pen

Simply click in an object to select everything that has the same color. You can
define a tolerance for the selection with a double-click on the tool.
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4.5 Eraser

Use this tool to erase using the current background color.
Double click on the symbol to get a dialog for selecting the eraser size and form.

4.6 Pencil

Use this tool to draw using the current foreground color and pen size.
Double click on the symbol to get a dialog.

You can select the kind of the cursor with the dialog.
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4.7 Eye dropper

Click on a pixel to change the foreground color in the toolbox to that of the
selected pixel. You can also hold the mouse button down as you move the eye dropper
around, releasing it when the correct color is detected. If the position window is active
(Picture>Show Position) the RGB color values and the closest HTML color code will be
displayed in it.

4.8 Fill

Use this tool to fill an enclosed region with the foreground color and pattern.

The dialog defines the range of colors that will be substituted for the fill. A low value
will restrict the range and higher values will expand it.
4.9 Line

Use this tool to draw a line with the foreground color and pen size.
Note: Pressing the shift key constrains drawing to vertical or horizontal lines.
4.10 Zoom

Use this tool to zoom in or out the picture.
Note: Click to zoom in. Hold the option key and click to zoom out.
4.11 Filled Rectangle

Use this tool to draw a rectangle filled with the foreground color, pen size and
pattern.
Note: Holding the shift key draws a square.
4.12 Rectangle

Use this tool to draw an empty rectangle whose border is the foreground color,
pen size and pattern.
Note: Holding the shift key draws a square.
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4.13  Filled Rounded Rectangle

Use this tool to draw a rounded rectangle filled with the foreground color, pen
size and pattern.
Note: Holding the shift key draws a symmetrical rounded rectangle.
4.14  Rounded Rectangle

Use this tool to draw an empty rounded rectangle whose border is the
foreground color, pen size and pattern.
Note: Holding the shift key draws a symmetrical round rectangle.
4.15  Filled Ellipse

Use this tool to draw an ellipse filled with the foreground color, pen size and
pattern.
Note: Holding the shift key draws a circle.
4.16  Ellipse

Use this tool to draw an empty ellipse whose border is the foreground color, pen
size and pattern.
Note: Holding the shift key draws a circle.
4.17 Text

Use this tool to place text on the picture. Display the dialog to define all settings
for inserting text.
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4.18 Transparent

 Use this tool to define or undefine the transparent color by clicking on the required
color in the image.

You can define the transparent color for copying by entering an index, selecting the
color in the color table, clicking in the picture or clicking on Set Back Color.
4.19 Movie tool

 Use this tool to resize  the frames of a GIF animation.
4.20 Slice tool

 Use this tool to define slices in an image. Slices are uses as clickable hyperlink
areas in an image for the Web. GraphicConverter will create an HTML page with a table
defining theses areas, HREFs and the required segmented images. Control-click inside a
slice to edit the URL or delete the slice with the contextual menu.
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You will see the following dialog upon selecting „Edit Slice URL“.

GraphicConverter saves the slice information in the resource fork of a file. So, you have
to enable the saving of the resource forks in the prefs part save.

You can define the location, names and background color for a slice in the options under
save as.

The above sample settings would create the following files if you saved the slice with
named it index.html:

index.html
images/index_0.jpg
images/index_1.jpg
etc.

4.21 Pen Size
Displays a popup menu to select a pen size between one and ten points.

4.22 Pattern

Displays a popup menu to select the pattern for filling.
You can tear off the menu and move it.
4.23 Foreground and Background Color

Displays a popup menu to select the foreground or background color.
You can tear off the menu and move it.
Note: If you have a black and white picture, the colors toggle between black and white.
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4.24 Pen Mode
Displays a popup menu to select the transfer mode from the following:

Copy, Or, Xor, Bic, Not Copy, Not Or, Not Xor and Not Bic
Changing the Selection
To change the size of a rectangular selection use the resizing boxes handles around the
frame.
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5 Keywords
GraphicConverter supports specific keywords which you can type in the Comment
window. The text following to the keyword will be mapped to special fields in some file
formats.

Example comment:
OWNER: Thorsten Lemke
COPYRIGHT: 1998
DESCRIPTION: This is a sample comment

The following table explains which GraphicConverter keyword is mapped to which tag
in the formats that support such information.

GraphicConverter
Keyword

TIFF VPB GIF JPEG TGA

TITLE Na Title
OWNER Artist (315) Owner
CATEGORY Na Category
DATE Date (306) Date
TIME Na Time as as as
DESCRIPTION Description

(270)
Description one

complete
one

complete
one

complete
COPYRIGHT Copyright

(0x8298)
na comment comment comment

HOST Host (316) na
SCANNER Scanner

(272)
na

SCANNERMAKER Scanner
Make (271)

na

SOFTWARE Software
(305)

na

Also, the content of the comment window will be saved to the resource fork of the
graphic file as a ‘TEXT’ resource when the option „Add Resource Fork“ in the
preferences part save is checked.
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6 Layout
Allows generation of simple layouts. This means that you can place several pictures of
different sizes on a page.
Insertion
If you click in a layout window while pressing the control key, you will get a popup
menu for selecting one of the open pictures.
Moving
You can move a picture by dragging it.
Change Size
If you select a picture, you can change its size using the resizing handles.
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7 List
The list window gives you an overview of the pictures or ‘STR#’ resources.
Change Page
Click in the ‘+’ or ‘-’ button to change the page.
Borders
The black frame shows the printable size. The red border shows the selected frame.
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8 Movies
Supported Movie Formats
GraphicConverter can play the following movie formats:
• *PICS - Animated PICTs
• *.ANI - Animated NeoChrome
• *.FLI - Autodesk Animator
• *.FLC - Autodesk Animator Pro
• *.DL - DL-Animations
• *.GIF - Animated GIFs
• *.PIC - BioRad animations
Play a Movie
If you load a movie, GraphicConverter displays a play button in the bottom left corner
of the window.

Click this button to play the movie in the window.

Click on the stop button to stop a movie.
If you select ‘Play’ from the ‘Picture’ menu, GraphicConverter plays the movie in front
of a black background.
Create a GIF Animation
You can easily create GIF animations with GraphicConverter. All available GIF settings
can be used. There are two methods to create an animation.
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Create a GIF Animation with Convert More
The simplest method is to use Convert More. Use it if all frames start at the top left of
the animation.
Choose Convert More from the File menu. Select all source frames in the left hand list
and select the destination folder in the right hand list. Choose GIF as the destination
format and then click on Options.

Description of the Movie Options. (An explanation of the other GIF options is given in
the section describing the Save As function).
• Create Movie

Check this option to create a GIF animation. Uncheck this option to create single GIF
files.

• Delay
Defines the delay between the display of each frame.

• No disposal
Each frame will be displayed above the last frame.

• Do not dispose
Same as No disposal.

• Restore to background
The background will be filled with the background color before the display of the
new frane.

• Restore to previous
The background will be restored to the frame before the last frame. The new frame
will be displayed after this operation. This is not supported by all decoders. A
decoder will use the mode “Restore to background” in this case.

• User Input
The decoder will wait for a mouse or key click after the display of the new frame.
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• Transparent
Starting with version 89a, GIF supports transparent mode. You can set one color of
the color table to transparent. You will see the background or last frame in the
transparent regions. You can set the index of the transparent color for all frames with
this option. For GIF animation, I recommend using the same color table for all
frames to reduce the size of the file. (A 256 color table occupies 768 bytes.)

• Loop
This option is supported by many internet browsers (Netscape >=2.0, Internet
Explorer >= 3.0). The GIF animation will loop continuously.

Manually creating a GIF Animation
Open a GIF animation or a single graphic file. Select “Show Movie Options” from the
Picture menu. GraphicConverter will display an alert if your file is not a movie. Click on
Convert if this appears.

You can adjust the settings for the current frame with this toolbox.
• Delay

Defines the delay between the display of each frame.
• Global Color Table

The current frame uses the global color table. Every GIF animation has one global
color table and optional local color tables. You should use only the global color table
to limit the file size. Every additional local color table requires 786 bytes for 256 color
frames. Also, some decoders can’t display animation with local color tables correctly.

• Local Color Table
The current frame uses a local color table. You can change colors without affecting
other frames.

• Insert Frame
Pastes a new frame from the clipboard into the movie.

• Delete Frame
Deletes the current frame.

• No disposal
Each frame will be displayed above the last frame.

• Do not dispose
Same as No disposal.
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• Restore to background
The background will be filled with the background color before the display of the
new frane.

• Restore to previous
The background will be restored to the frame before the last frame. The new frame
will be displayed after this operation. This is not supported by all decoders. A
decoder will use the mode Restore to background in this case.

• User Input
The decoder will wait for a mouse or key click after the display of the new frame.

• Transparent
Starting with version 89a, GIF supports transparent mode. You can set one color of
the color table to transparent. You will see the background or last frame in the
transparent regions. You can set the transparent color with the transparent tool from
the toolbar.

• Loop
This option is supported by many internet browsers (Netscape >=2.0, Internet
Explorer >= 3.0). The GIF animation will loop continuously.

You can navigate between the frames with the controls at the bottom of the picture.

Controls for Navigation

Other Formats
Other formats like QuickTime can use only the delay value from the animation.
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9 Supported file formats

Format Import Export Comment
.D • • 320x200 pixel at 1 bit

8BIM • • old Photoshop 2.0 format

• supports 1, 8 and 24 bit per pixel

Acorn Sprite • • contains sprites from Acorn computers

AFP • • variant of the TIFF format for 1 bit images

ALIAS • • Alias Pix format

• Supports 256 grays or 24 bit.

AMBER ARR • • Used by a microscope.
• Supports 256 grays.

ANI • • Animations from the NeoChrome application

ANPA • • Format with IPTC details.

Apple Preferred • • Format des images Apple IIgs

ART • • Format of First Publisher

• Supports 1 bit per pixel

ASCII • • • Option for importing and exporting images as
ASCII characters.

BioRad • • BioRad file format.

• Support 256 grays

BLD • • • Format of Mega Paint

BMP • • • Standard Windows format.

• Supports 1, 4, 8, 15 and 24 bit per pixel

BUF • • Supports 32 bit

BUM • • • Variant of the BMP or PICT format

CAM • • Format of the Casio QV-10/100

• Variant of the JPEG format

CALS • • CCITT 4 compressed black & white images
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Format Import Export Comment
CEL • • • CEL format

CGM • • International standarized file format for exchange
of image with vector and bitmap content

System 7 clip • • Clipping if System 7 or later

CLP • • Clipboard format of Windows

CT • • Scitex color images

CVG • • Calamus vector format

DCX • • Contains multiple PCX files.

DESR VFF •
DICOM • • Medical format

DJ1000 • • Camera format

DL • • Animation format with 320 x 200 pixel at 8 bit.
• Contains normally x-rated content.

Doodle •
DPX •

Dr. Halo • 1. Format of the Dr. Halo application
2. Uses 256 colors.

ElectronicImage • • • Electric Image format.
• It may contain animations.

EPSF • (*) • • Postscript format.

• (*) GraphicConverter need a helper application for
opening such a file.

ESM • • ESM format

FAX • • CCITT 3 encoded fax file

FaxSTF • • Format from the FaxSTF software

FireViewer PDB • • • FireViewer Palm format

• Supports black&white, 4 and 16 grayscale and 256
colors
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Format Import Export Comment
colors

FITS • • Flexible Image Transport System format.

• Normally used for science.

FLH/FLI/FLC • • Animation from the Autodesk Animator.

• FLI supports 8 bits at 320 x 200 pixel.

• FLC support 8 bits at 640 x 480 pixel.

• FLH supports high color.

FPX • (*)
• FlashPix file format.

• (*) Requires QuickTime 4 or later.

FUJI •
GATAN • • Format of a microscope.

• Supports 256 grays.
GEM • • Vector images (GEM-Metafile) from the GEM-

Draw application.

GFX • • Format of Xgrabber

GIF • • • Supports 1 to 8 bit per pixel.

• Format was created by CompuServe Inc.

GRP • • Uses 1 or 4 bit per pixel.

HAM • • Format Interchange File Format (IFF)

HP-GL/2 • • • Vector images.

• This format is normally used from plotters.

IBM – PIC • • Supports 16 bit per pixel.

IC ? – Imagic • • Format of the ATARI application Imagic.

• Supports the three color modes of the ATARI.

ICO/ICN • • • Format of the Windows file icons.

IFF/LBM • • • Standard file format of the Amiga.

• Supports all color depths.

Image -> Finder • • Creates an image in a folder by creating custom file
icons ; this is very usefull for cd-rom creation

ImageLab /
PrintTechnic

• • Images with 256 grays.
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Format Import Export Comment
IMG/XIMG • • • GEM-Draw file format. Supports 1 to 8 bit per

pixel. The specificiations of the 24 bit per pixel
variant was never offical released.

IMQ • • Satellite image format.

IPLab •
ISS •
j6i • • Variant of the JPEG format.

JBI • • Variant of the TIFF format

JIF • • • New format based on TIFF.
• But it uses the zlib compression.

JPEG/JFIF • • • Supports 24 bits per pixel or 256 grays.

• Uses lossy compression.

• Additional EXIF information (from digital
cameras) is supported.

KDC • (*)
• Format of the Kodak digital camera

• (*) Requires a PPC for opening

KISS CEL • •
Koala • • C64 format

KONTRON • • Format of the Kontron microscope
• Contains images that use 256 grays.

LDF (Lura-
Document) •

Lotus-PIC • • Vector format of the Lotus spreadsheet
application.

LWF (LuraWave) • • • LuraWave wavelet compression technolgy

MacPaint • • • Black and white image with 576 x 720 pixels

MAG • • MAKIchan graphic format

MAYA-IFF • • Variant of the IFF format.

MBM
(Psion 5) • • • Images of the PSION serie 5
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Format Import Export Comment
Meteosat 5 • • Format of the meteosat satellite.

Moov • • Animation QuickTime

MSP • • 1 bit images from Microsoft Paint (Windows 2.0).

MSX – MSX2
MSX+ - MSX2+

•
NASA Raster

Metafile • • Format (with or without multiple frames) from
the NASA missions.

NEO • • Format of the ATARI application NeoChrome.

• Supports 320 x 200 pixel at 16 colors.

NGG/NCG • • • Format of Nokia mobile phones.

NIF •
NOL • • • Format of Nokia mobile phones.

ONCOR • • Supports 256 grays.

P ? ? – Degas • • Format of the ATARI application Degas
• 320 x 200 pixel, 16 colors (*.PI1, *.PC1)
• 640 x 200 pixel, 4 colors (*.PI2, *.PC2)
• 640 x 400 pixel, 2 colors (*.PI3, *.PC3)

Palette • • color table

PAC – STAD • • Black & white 640 x 400 pixel images of the
ATARI application STAD.

PBM – PGM
PPM

• • • Standard UNIX file format for easy exchange of
images.

• Support 1, 8 or 24 bit per pixel.
• The files can be encoded binary or ASCII

PCD • • Kodak PhotoCD format

PCX • • • Format of PC-Paintbrush.

• Support 1, 4 and 8 bit per pixel. The new variant
supports 24 bit per pixel, too.

PIC (32K) • • Black & white 640 x 400 pixel image of the
ATARI..



130

Format Import Export Comment
PIC • • B&W ATARI image format (640x400 pixel)

PIC • • Format from PC Paint

PIC • • • Format of the Psion.

• Supports 1 or 2 bit per pixel.

PICS • • • Animations PICT.

PICT • • • standard MacOS file format

• contains vector and/or bitmap images

PICT resource • • • PICT that is written/read from the resource fork of
a file

PDB • • • Palm Pilot format. There exist a lot of variants.
GraphicConverter supports TealPaint, FireViewer
and ScreenShot Hack

PGC/PGF •
PM • • Format of the UNIX xv application.

PNG • • • New internet file format.

• It supports 1, 2, 4, 8 and 24 bits per pixel.

PORST • • Photo on disk format.
• Variant of the JPEG format.

Ppat • •
PSD • • • Photoshop 3.x or later file format.

• Supports 1, 8, 24 bit per pixel.

PSP • • PaintShop Pro format

QDV • • Giffer format
• Supports 1, 4 and 8 bits per pixel.

QNT •
QTIF • (*)

• QuickTime image format.
• (*) Requires QuickTime 3 or later.

RAW • • • You can use the raw filter to import raw data.
You have to specify the width, height and color
depth during opening or saving such a file.
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Format Import Export Comment
RIFF • • Contains color and black & white images (format

of the Painter software)
RLA •
RLE • • Images of the Utah Raster toolkit.

RTF • • Rich Text Format.

SCR • • • Images of the capture tool of word for DOS. The
format is identical with PCX.

ScreenShot Hack
PDB • • Contains a Palm screenshot (160x160 pixel)

SCX • • Format of ColoRIX
• Supports 8 bit per pixel

SFW • • Seattle Filmworks photo on disk format.
• Variant of the JPEG format.

SGI • • Silicon Graphics Image format.
• Supports 256 grays or 24 bit.

SHP • • Format of the image library of Lighting Press or
Printmaster.

• Support 1 bit per pixel.
Sinclair QL • • Format of the Sinclair QL

SIXEL • • Terminal format from the VAX world.

SKETCH • • Variant of the MBM format.

SNX • • A modification of the JPEG format

SOFTIMAGE • • • Format of Softimage.
• Supports 32 bits per pixel.
• Used for video applications.

SPC • • Image of the Spectrum application.
• Supports 320 x 200 pixel at 512 colors.

ST – X – SBIG • • Supports 256 grays.

StartupScreen • • • This file can be placed in the system folder ; so, the
MacOS will display the image during startup

SUN • • SUN Raster file format.
• Supports 8 or 24 bit per pixel.

Super-Hi-Res 3200 • • Images with 32000 colors of the Apple Iigs
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Format Import Export Comment
SWF • • Flash

TCL • • TCL format

TealPaint PDB • • Palm TealPaint file format
• Supports black&white and 256 colors (default

Palm color table)
TGA • • • Format from Truevision Targa

• Support 1, 8, 15 and 24 bits per pixel.
TIFF • • • complex format for all color depths

• GraphicConverter can import and export the
following compression kinds : uncompressed,
packbits, lzw, ccitt3, ccitt4, fax3, fax4

TIM PSX •
TN ? • • Format of the ATARI application TINY

TRS-80 • • • Format of the TRS-80-

VBM •
VFF • • Uses 4 bit per pixel

VGS-8 • • Used by a microscope.
• Supports 256 grays.

VITRONIC • • Vitronic format.
• Supports 256 grays.

VOXEL • • 512 x 512 pixel at 256 grays format.

VPB • • • Format of the Quantel video system.

VPM •
WBMP • • • Format for the new WAP technology.

WMF • • • Windows – Meta File.
• Contains vector and bitmap images.

WPG • • Graphic file format of Word Perfect.
• It can contain bitmap and vector images.

X11 • • Bitmap.
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Format Import Export Comment
XBM • • • Black & white format that is C encoded.

X-Face • • • Supports 48 x 48 pixel at 1 bit.
• Used for small photos in newsgroups.

XPM • • • Bitmap ASCII.

XWD • • • Dump of X - Windows.
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10 Shortcuts
Always
Shortcut Result
Control-click within a window Displays the context menu
Option-click a window title Displays a popup menu showing all

open windows. Brings the selected
window to the front.

In Pictures
Shortcut Result
Control-option-click on an image Displays a popup menu to select the

picture view size.
Control-click on an image Displays a contextual menu to choose

help or select all.
Option key in an image Enables the eye dropper.
Command-option keys in an image Moves the selection (opaque) within the

window.
Shift-option keys in an image Scrolls the image (only available if the

window does not show the complete
image)

Cursor keys No selection - scrolls the contents of the
active window Selection - Moves the
selection. With shift held down changes
the size of a rectangular selection

ESC Cancels the selection.
In Layouts
Shortcut Result
Control-click on the Layout Displays a contextual menu to insert an

open picture.
Control-click on a picture in the Layout Displays a contextual menu to select the

picture size.



135

11 E-Mail and Attachments
I get a lot of e-mails regarding mailing of images from a Mac computer to a PC. So, this
chapters show you how to set up the different e-mail applications.
11.1 Outlook Express
Write your e-mail. Add the attachment with drag and drop. Click on the encoding area
and select „Windows (MIME/Base64)“. Send the message.

11.2 Eudora Pro
Write your e-mai. Add the attachment with drag and drop or use the Attach Document
button. Click on the encoding area and select „AppleDouble („MIME“)“. Send the
message.
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11.3 Claris E-Mailer
Write your e-mail. Add the attachment with drag and drop. Click on the encoding menu
and select „Base 64“. Send the message.

11.4 America Online
There is no way to change the encoding in AOL. A solution is to save the files before e-
mailing without a resource fork. You can disable the creation of a resource fork in the
preferences part Save.
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11.5 CompuServe
Write your e-mail. Add the attachment with drag and drop. Click on the „send as“
menu and select „Binary“. Send the message.

11.6 Netscape Navigator
There are no special settings for Netscape e-mails. Your attachment will be
automatically encoded as „base 64“.
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12 FTP of Images
I get a lot of e-mails regarding uploading images from a Mac computer to web server.
So, this chapters show you how to set up the different ftp applications.
12.1 Fetch
Select Preferences from the Customize menu. Select „Raw Data“ as the default non-text
format.

12.2 Transmit
There are no special settings. Transmit uses your internet settings for the correct file
transfer.
12.3 Anarchie
Select Preferences from the Settings menu. Uncheck the „Allow MacBinary“ option.
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13 Developer Section
13.1 Plug-ins
You can develop file import and export and filter plug-ins for GraphicConverter. The
SDK is available for free from http://www.lemkesoft.com/us_plugins.html.
13.2 Apple Events
You can use GraphicConverter 3.8 or later as an external editor for images.

You have to use the following calling convention for this operation:

Create an ‘odoc‘ event with the file in a typeAEList as the keyDirectObject and
with the key ‘FSnd‘ your application creator as ‘type‘.

GraphicConverter sends events after the following user actions:

• Closing the file
You get an event ‘R*ch‘/‘FCls‘ with the file FSSpec as keyDirectObject of type
typeFSS and your application creator from the call as key ‘FSnd‘ of type ‘type‘.

• Saving the file
You get an event ‘R*ch‘/‘FMod‘ with the file FSSpec as keyDirectObject of type
typeFSS and your application creator from the call as key ‘FSnd‘ of type ‘type‘.

• Saving the file with a new name
You get an event ‘R*ch‘/‘FMod‘ with the original file FSSpec as keyDirectObject of
type typeFSS and the new file FSSpec as ‘New?‘ of type typeFSS and your
application creator from the call as key ‘FSnd‘ of type ‘type‘.

You can call GraphicConverter for direct image conversion:

Create an ‘xCnf ‘ event with the class ‚gcSt‘.
Add the following parameters to the object:
• Integer with key ‚kywf‘
• Source FSSpec record with key ‚kysc‘
• Target FSSpec record with key ‚kytg‘

Use the following values for the integer:
C_SPICT = 1;
C_SMacPaint = 2;
C_STIFF = 3;
C_SGIF = 4;
C_SIFF = 5;
C_SPCX = 6;
C_SImage = 7;
C_SStartupScreen = 8;
C_SBMP = 9;
C_STGA = 10;
C_SJFIF = 11;
C_SPSD = 12;

http://www.lemkesoft.com/us_plugins.html
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C_SHPGL = 13;
C_SEPSF = 14;
C_SMovie = 15;
C_SSun = 16;
C_SPICS = 17;
C_SResource = 18;
C_SPPM = 19;
C_SSGI = 20;
C_STRS80 = 21;
C_SPPAT = 22;
C_SSoftImage = 23;
C_SPNG=24;
C_SPalette=25;
C_SRAW=26;
C_SPSION=27;
C_SWMF=28;
C_SXWD=29;
C_SXBM=30;
C_SXPM=31;
C_Sclpp=32;
C_SASCII=33;
C_SPAC=34;
C_SICO=35;
C_SRTF=36;
C_SVPB=37;
C_SIconWand=38;
C_SMBN=39;
C_SXFace=40;
C_SPDB=41;
C_SSlice=42;
C_SISS=43;
C_SCEL=44;
C_SWBMP=45;
C_SPGC=46;
C_SHandyNGG=47;
C_SHandyNOL=48;
C_SJIF=49;
C_SBLD=50;
C_STCL=51;
C_SPICTAusResource=52;
C_SBUM=53;
C_SElectricImage=54;
C_SLuraWave=55;

GraphicConverter trys to convert the file to the destination format.
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